
Contents

Common Ground MiniViewer Online Help
Contents
What is Common Ground?
Using this Common Ground MiniViewer
How to save time and reduce costs using Common Ground
Twenty-five ways to use Common Ground
Distributing Common Ground

No Hands Products
Common Ground product line
Common Ground resellers
How to contact No Hands Software

To see help on a topic, click on it.    
For information on using Help, choose How to Use Help from the Help menu.

Call No Hands Software today for information on our latest promotion.
Phone: (415) 802-5800
Fax: (415) 593-6868



Using This Common Ground MiniViewer
Document navigation
Printing a Common Ground document
Print Setup
Menus
Keyboard shortcuts



How to Save Time and Reduce Costs Using Common 
Ground
Today’s world revolves around information.    The timely dissemination of information is 
critical to the success of almost every organization and individual.    Now, you’re probably 
producing most of your information electronically on a PC and printing to paper, then 
distributing the paper via the mail (internal or federal) or a courier.    This process is 
relatively slow and expensive.    

With Common Ground, you can send any document electronically and have it arrive 
instantly to one person or thousands.    Electronic distribution is simpler and saves on 
printing, paper, and transport costs.    Your recipients can conveniently print on demand.    
They see the document exactly as you intended with all graphics, fonts, formatting and 
color intact.    This is true no matter what computer platform, applications, or fonts your 
recipients are using.

There are other advantages to distributing electronic documents.    Recipients can reuse the
text and graphics (only if you let them), and tools such as searching and thumbnails help 
them navigate around the document to locate important information quickly.    

Since your recipients won’t be printing everything you send, you reduce the consumption 
of a valuable resource--paper.    So when you use Common Ground, you not only become 
more efficient, but you do something good for the environment.      



Twenty-Five Ways to Use Common Ground
Here are some of the ways that others are using Common Ground to improve their 
efficiency.    These are just meant to get the wheels turning for you.    If you have any 
questions, we encourage you to contact us.    (See How to Contact No Hands Software.)

1. E-mail users can enclose a Common Ground document in a message, and be certain 
the recipient will be able to view and print without worrying about their computer 
platform, applications or fonts.    

2. Internet and other on-line service users can send documents to another continent 
and have them arrive instantly with all graphics, fonts, formatting, and color intact.

3. Marketing can distribute fully formatted materials to the sales force, confident that 
the "corporate identity" will be preserved.

4. Organizations can publish information organization wide (e.g., press releases, reports,
phone lists, human resource manuals, etc.).

5. Project managers can distribute status or performance reports with Gantt charts, 
spreadsheets, charts and graphs, improving the effectiveness of their 
communication.

6. Marketers can make their presentations portable--print them to DigitalPaper, then 
carry the resulting Common Ground file on a floppy, confident that they can give the 
presentation on any PC without worry as to whether the application or fonts are 
present.

7. Documentation groups can distribute drafts of manuals for review.
8. Anyone can send a letter on their own distinctive letterhead to anyone else.
9. Legal can send contracts with boilerplate that can be copied and pasted into other 

documents for re-use.
10. Finance can distribute management reports to the rest of the organization, without 

worry as to who is using which version of which spreadsheet on which platforms.
11. Publishers can now distribute their newsletters electronically and have them arrive 

faster with the layout, pictures, and graphs preserved.
12. Graphic artists can distribute to clients comps or final documents that can be viewed,

printed and faxed as an exact representation of original.
13. Job seekers can send or post their resumes electronically.
14. Organizations can send or post their sales and promotional materials electronically, 

opening a new distribution channel.
15. Sales reps can fax a form created by MarComm in QuarkXpress or PageMaker, saving 

them from purchasing or pirating these applications.
16. Technical support can post fully formatted files on an electronic bulletin board, with 

assurance that anyone can view and print them.
17. Companies can archive their documents in Common Ground knowing that they can 

be searched, retrieved and used by anyone in the organization.
18. Publishers can distribute information with copying and printing disabled to limit 

undesirable dissemination of valuable information.
19. Telecommuters can exchange formatted documents with the office, knowing the look 

of their work will be preserved.
20. Engineers can deliver CAD drawings electronically for review or final approval.
21. CD-ROM publishers can distribute their documentation in Common Ground, saving 

money and improving their time to market.
22. Human resources can post employee handbooks, new job listings, and organizational 

charts for all employees to browse and print on demand.
23. Customer service can take product collateral created on a Macintosh in FrameMaker, 

convert it to Common Ground, and embed it in a database where any customer 
service rep using a Windows PC could access it quickly when talking to a customer 
(i.e., Common Ground is an OLE 2.0 server)

24. Lotus Notes users can easily convert documents created outside of Notes to Common



Ground and embed them in a Notes database.    Other Notes users will be able to 
immediately search, retrieve, view, and print those documents, which appear exactly 
as they did when created.    The complete text of the Common Ground documents will
be indexed automatically and can be searched by the Notes full text search engine.

25. You can share any formatted document with anyone else with complete confidence 
they will be able to view and print an identical copy to your original, without worrying
about what computer platform, applications or fonts are at the other end.



Common Ground Product Line
Common Ground

Common Ground, available for both Macintosh and Windows, consists of a Common 
Ground Maker, a Common Ground Viewer and a Common Ground MiniViewer.    The 
Common Ground Maker allows you to create Common Ground documents.    It also 
includes both a Common Ground Viewer and a Common Ground MiniViewer.

Anyone who wishes to create Common Ground documents will want to purchase 
Common Ground.    

Common Ground is available from the listed resellers.    (See Common Ground 
Resellers.)        Contact No Hands Software, in the USA, for information on volume 
purchases, corporate licenses and publishing licenses by calling (415) 802-5800 or 
faxing (415) 593-6868. 

Common Ground MiniViewer
The Common Ground MiniViewer, available for both Macintosh and Windows, allows 
recipients to view and print Common Ground documents.    It includes some basic 
navigation features such as next page, previous page and go to a specific page.    You 
can embed the MiniViewer inside a Common Ground document so that it can be 
opened by double-clicking, or you can send a copy of the stand-alone version of the 
MiniViewer along with your document.

The Common Ground MiniViewer is useful for distributing information when your 
recipients only need to be able to view, print, and have basic navigation capabilities.

The    Common Ground MiniViewer license allows you to freely distribute the Common 
Ground MiniViewer for non-commercial purposes.    If you wish to distribute the 
Common Ground MiniViewer for commercial purposes, contact No Hands Software.

Common Ground Viewer
The Common Ground Viewer has all the features of the Common Ground MiniViewer, 
plus several other advanced features:
It allows you to search for text within a document. 
Documents can be magnified or reduced.    
Text and graphics can be copied from a Common Ground document and pasted    into 

another application to be reused.
Common Ground documents can be inserted in OLE 2 clients and embedded in Lotus  

Notes databases. 

The Common Ground Viewer is useful for distributing information to a group who 
want to be able to quickly search the document or to copy text and graphics for reuse
in other applications.

The Common Ground Viewer can also be licensed from No Hands Software.    If you 
wish to distribute the Common Ground Viewer with your documents, contact No 
Hands Software for licensing information.

These are our current products as of February 16, 1994.    In the future, No Hands will be 
introducing more products, releasing Common Ground on other platforms, and upgrading 
Common Ground for Windows and Macintosh.    Contact No Hands Software for current 
product information.



Common Ground Resellers
NORTH AMERICAN NATIONAL RETAIL STORES

Please call 1-800-598-3821 for latest reseller information.

NATIONAL MAIL ORDER CATALOGS

Mac Connection
800-800-2222 FAX 603-446-7791

Common Ground for Macintosh Part number:    8890

PC Connection
800-800-0005

Common Ground for Windows Part number:    14840

Mac Warehouse
800-255-6227 FAX 908-905-9279

Common Ground for Macintosh Part number:    GRA 0388

(PC)MicroWarehouse
800-367-7080 FAX 908-905-5245

Common Ground for Windows Part number:    UT4313

RESELLERS PLEASE CONTACT: 

Ingram Micro
800-456-8000

Common Ground for Macintosh (single user) Part number:    218106
Common Ground for Windows (single user) Part number:    218108
Common Ground 10-user pack (Mac/Win) Part number:    1060

or call 415-802-5800 for site license and publishing license information.

International Distributors
Austria

Target Distribution
Vorarlberger
Wirtschaftpark
6840 Goetzis
Phone:    5523-54871
Fax:    5523-54873

Australia
Mitsui Computer Ltd.
14 Aquatic Drive
Frenchs Forest
NSW 2086
Phone:    61-452-0452
Fax:    61-452-0481



Belgium
Plus Products
Begoniastraat 17
B-9810 Nazareth
Phone:    091-85-58-00
Fax:    091-85-60-16

France
Aware
21, rue Olivier Metra
75020 Paris
Phone:    (1) 46 36 46 47
Fax :    (1) 46 36 82 54

Germany
Softline GmbH
Renchener Strasse 3
D-77704 Oberkirch
Phone:    (07802) 924-0
Fax:    (07802) 924-240

Japan
SOFTWARE.Too
Tango 33 Blgd.3F
3-25-11 Higashi
Shibuya, Tokyo, 150
Phone:    03-3797-5778
Fax:    03-3797-5799

Netherlands
Signal B.V.
Caïrostraat 51
3047 BB Rotterdam
Phone:    10-2081600
Fax:    10-4157667

Switzerland/Luxembourg
Systrade AG
Langenhagstrasse 3
4147 Aesch BL
Phone:    (061) 751-5111
Fax:    (061) 751-5157

United Kingdom
Fontworks UK Ltd.
65-69 East Road
London N1 6AH
Phone:    071-490-5390
Fax:    071-490-5391



What is Common Ground?
Common Ground lets you easily convert any document from any Windows application to an
exact representation that can be viewed and printed by anyone, regardless of their 
applications, computer platform, or fonts.

You can distribute Common Ground documents to others, confident that recipients will be 
able to view and print them as an exact representation of the original.

No Hands Software sells both Windows and Macintosh versions of Common Ground.    
Common Ground makes it possible to view Macintosh documents within Windows and 
Windows documents on a Macintosh, provided you have the Common Ground Viewer or 
MiniViewer (described below).

Components of Common Ground
The Common Ground software consists of three parts:
1    The Maker

Creates a Common Ground version of your application document.
2    The Viewer

Lets anyone read, search, copy from, and print Common Ground documents.
3    The MiniViewer

Lets anyone read and print Common Ground documents.    Can be embedded within a
document and freely distributed for non-commercial purposes.

The Common Ground Maker
From within any Windows-based application, you can create a Common Ground 
version of any document using the Common Ground Maker.

The Maker is actually a set of Windows printer drivers, one for standard applications 
and one for PostScript applications.    Either driver creates a copy of your document in
Common Ground format, then prints it to a disk file.    The resulting document can 
then be read using either the Common Ground Viewer or MiniViewer.

The Common Ground MiniViewer
The MiniViewer supports document viewing, printing, and simple document 
navigation.

Embedded MiniViewer
The creator of a Common Ground document can embed the MiniViewer in the 
document at the time it is created.    

A document with an embedded MiniViewer has a filename with an .exe extension to 
show that it is "self-launching".    When the document is opened, the MiniViewer starts
up automatically and displays the document.

Stand-alone MiniViewer
The MiniViewer can also be distributed freely for non-commercial use as a stand-
alone application.    In this form, it can be installed as an icon in a Windows program 
group.

You can open a Common Ground document from the stand-alone MiniViewer using 
the standard Open command on the File menu.



The Common Ground Viewer
The Viewer is a software tool for viewing, manipulating, and printing Common Ground
documents.    It has all the features of the MiniViewer.    In addition,    it allows you to:
Search for text in a document
View a document one page or many pages at a time
View multiple documents at one time
View the document at a range from 25% to 400% of normal size
Copy text and graphics from a document to the Windows Clipboard
Save as into other file formats

For information on upgrading from the Common Ground MiniViewer to the Common 
Ground Viewer, choose the Information command from the Upgrade menu.



Document Navigation
Navigation is the process of moving around in a Common Ground document, either on a 
single page, or from page to page in a multiple-page document.

Navigating Within a Single Page
You may use any (or all) of the methods listed below.

Scroll Bars
Use the scroll bars to move the current page up and down or from side to side.
NOTE:    The vertical scroll bar does not move from page to page.    It operates only on
the currently displayed page.

Keyboard
>    The up and down arrow keys move the current page in the specified direction in 
small increments.
>    The PgUp and PgDn keys move the current page in the specified direction in 
larger increments.
>    HOME and END move to the beginning and end of the page.

Navigating From Page to Page
To move from one page to another in a document, you must use the commands on the 
Page menu (or their keyboard shortcuts).

Command             Shortcut                        What it Does
First CTRL+HOME Displays the first page
Previous CTRL+PgUp Displays the previous page
Next CTRL+PgDn Displays the next page
Last CTRL+END Displays the last page
Go to... Displays the page you specify



Printing a Common Ground Document
When    a document is displayed in the MiniViewer window, you can print it to your local 
printer or to a disk file.
NOTE: If the document was created with print privileges disabled, the Print command will 
be dimmed and the document cannot be printed.

To print a Common Ground document:

1. Choose Print from the File menu.    The Print dialog box opens.

2. The active printer is listed at the top of the dialog box.    If you want to change it, do so 
in Print Setup.    See Print Setup.    
NOTE:    If Common Ground Maker is the active printer, you must select a different 
printer in order to print the document.

3. Select a print range option.    If you select Pages, enter the first and last page numbers in
the "From" and "To" boxes.

4. Select the desired print quality.
Click on the down arrow to see a list of choices.    They will vary, depending on which printer is active.

5. Select other options, if desired, by clicking in the appropriate checkboxes.
Print to File prints the document to a disk file.    Common Ground prompts for a 

filename.
Print Text as Graphic may improve printing under some conditions.    (See the note 

below.)
Collate Copies prints all pages in sequential order for multiple copies.

6. Enter the number of copies desired in the Copies box.

7. Choose the OK button.

NOTE on Print Text as Graphic: 
When you print a document, Common Ground converts the text to soft fonts, which it 
downloads to your printer.    This conversion causes the document to print faster.

However, for some documents that contain numerous fonts, or for some printers, this 
conversion can slow printing, distort the characters, or overflow the printer's memory 
resources.    

If your document prints too slowly, if the fonts in the printed document don't look quite 
right, or if your printer misbehaves while printing, select the Print command again and 
check this box.    It will prevent the conversion of characters from text to soft fonts and 
ensure a faithful printed copy.



Print Setup
Print Setup lets you specify the active printer, paper orientation and size, and access 
additional setup options via the Options button. 

There are two ways to get to Print Setup.

1. Click on the Setup button (if present) in the Print dialog box.    OR, 

2. Choose Print Setup from the File menu.

Print Setup Dialog Box
Printer
The default printer is the one that is automatically selected when you first open this dialog 
box.    You set the default printer (and change the setting) in the Printers Control Panel    in 
the Windows Program Manager.

To temporarily change to a different printer, select the Specific Printer option button.    Click 
on the down arrow to see a list of printer options, then select one.    This selection remains 
in effect until you change it or leave the Common Ground program.
NOTE:    You cannot select the Common Ground Maker as your printer while in the Common 
Ground program.    Doing so will give you an error message.

Orientation
This setting allows you to specify how the document text will be oriented on the page.

Portrait is the standard vertical orientation, in which the page is longer than it is 
wide when the text is upright.

Landscape is the horizontal orientation, in which the page is wider than it is long 
when the text is upright.

Paper Size and Source
Set your paper size and source to match the size and source in your printer.    Available 
choices vary with the active printer.    Click on the down arrow to see the choices.    

Options
Choose the Options button to open the Options dialog box.    In it, you can choose settings 
that ensure your Common Ground document will print as desired.    In general, they control 
various aspects of the print quality (intensity, grayscale, etc.).

The exact appearance of the Options dialog box and the settings available vary from 
printer to printer.    The active printer will determine which settings are available.

See also
Printing a Common Ground Document



Menus
File Menu
Open...
Document Info...
Print...
Print Setup...
Exit

Page Menu
First
Previous
Next
Last
Go to...

Upgrade Menu
Information...

Help Menu
Contents...
Search for Help on...
How to use Help
About Common Ground...



Print Command      (File Menu)
Prints the open Common Ground document to a printer or disk file.

Keyboard shortcut: CTRL+P

Print is dimmed if:
No document is open, OR
The open document was created with print privileges disabled.    (The creator 

specified that printing was not to be allowed.)

When you choose Print, the Print dialog box opens.    You can choose to print all pages or 
just specified pages.

If Common Ground Maker is listed as the active printer, you must choose the Setup button 
and select a different printer to print the document.

See also
Printing a Common Ground document
Print Setup



Print Setup Command    (File Menu)
Lets you specify the active printer, as well as select paper orientation, size, and source.    
Also gives you access to other setup options via the Options button.

Since different printers have different capabilities, the exact contents of the Print Setup 
dialog box will vary with the printer selection.

See also
Print Setup
Printing a Common Ground document



Exit Command    (File Menu)
Closes the Common Ground document that is open and exits from the program.

Keyboard shortcut: ALT+F4



First Command    (Page Menu)
Goes to the first page of the displayed document.

Keyboard shortcut: CTRL+HOME

If you are viewing the first page of the document, First is dimmed.



Previous Command    (Page Menu)
Goes to the previous page of the displayed document.

Keyboard shortcut : CTRL+PgUp

If you are viewing the first page of a document, Previous is dimmed.



Next Command    (Page Menu)
Goes to the next page of the displayed document.

Keyboard shortcut: CTRL+PgDn

If the document has only one page, or if you are viewing the last page, Next is dimmed.



Last Command     (Page Menu)
Goes to the last page of the displayed document.

Keyboard shortcut: CTRL+END

If the document has only one page, or of you are viewing the last page, Last is dimmed.



Go to Command    (Page Menu)
Opens a dialog box in which you specify the number of the page to display. 

If the document has only one page, Go to is dimmed.



Information Command (Upgrade Menu)
Displays a window containing information on contacting No Hands Software to upgrade the 
Common Ground MiniViewer to the complete Common Ground Viewer, or to license the 
Common Ground MiniViewer or the complete Common Ground Viewer.



Contents Command    (Help Menu)
Displays a list of the main topics in the Common Ground online Help system.    To display 
the Help for any topic, click on that topic.

Keyboard shortcut: F1



Search for Help on Command    (Help Menu)
A short-cut to the Search button within the online Help system.    Search lets you locate help
on a word or phrase.

When you choose Search for Help on, the Search dialog box opens.

To search for Help on your topic:

1. Type a word or phrase in the top box, or select one from the list.
Notice as you type that the list scrolls to show any words and phrases that start with the word(s) you 
typed.

2. Choose the Show topics button.
Any Help topics keyed to the word(s) you selected in the upper list box are displayed in the lower list box.

3. Select the desired Help topic from the lower list box.

4. Choose the Go To button to display the selected Help topic.



How to Use Help Command    (Help Menu)
This command takes you into a tutorial on how to use the online Help system.

The tutorial includes information on:
The different parts and features of the Help system
How to move around in Help
How to search for Help on your topic



About Common Ground Command    (Help Menu)
This command displays a window containing some basic information about the Common 
Ground MiniViewer software.

The information displayed includes:
Product name
Version Number
Copyright date
Company Name



Keyboard Shortcuts
You can use key combinations to quickly execute certain commands on the menus or to 
scroll through a multiple-page Common Ground document.

To Press

Print the open document CTRL+P

Exit Common Ground ALT+F4

Go to the first page of a document CTRL+HOME

Go to the previous page CTRL+PgUp

Go to the next page CTRL+PgDn

Go to the last page CTRL+END

Display Contents for the Help system F1



How to Contact No Hands Software
No Hands Software, Inc.
1301 Shoreway Road, #220
Belmont, CA    94002    USA

In the USA:    (800) 598-3821
Main:       (415) 802-5800
Fax:       (415) 593-6868



Open Command    (File Menu)
Starts the Open Dialog which allows you to choose a Common Ground document to view.

Keyboard Shortcut: CTRL+O

The Open dialog provides you with the ability to navigate through your drives and 
directories and list the documents in them by type.    You can only have one document open
at a time in the MiniViewer.



Document Info (File Menu)
Displays information about the Common Ground document you are currently viewing.

Keyboard Shortcut: CTRL+I

If no document is open, Document Info is dimmed.

The Document Information dialog box is divided into two sections:
1 Info Basic information about the document
2 Security Information about which security options, if any, are in effect
NOTE: The security options are more fine scale than what the Windows Common Ground 
Maker offers in order to support Macinstosh security features.



Distributing Common Ground
You can distribute Common Ground documents easily to business associates, customers, 
and friends for non-commercial use.    In addition, you can freely distribute the Common 
Ground MiniViewer that allows the recipient to view a Common Ground document.

If you want to distribute the MiniViewer or the complete Viewer for commercial purposes, 
contact No Hands Software.

Distributing Common Ground Documents
Once a Common Ground version of a document has been created, it becomes a file 
with either a    .dp filename extension or an    .exe filename extension.    (Files with an 
embedded MiniViewer have an .exe extension.    NOTE:    Macintosh users cannot open
these files by double-clicking.    However, they can open these files using the 
Macintosh Viewer.)

You can send a Common Ground file via electronic mail, post it to a bulletin board, or 
simply copy it to a disk to be mailed or hand carried.

To read it, the recipient needs only a computer running Windows or a Macintosh (for 
the Macintosh version of Common Ground).    If they have the Common Ground 
Viewer, they can    open, read, manipulate, and print your document. 

 
If they don't have Common Ground, you can embed the MiniViewer in the document 
itself.    The document thus becomes "self-launching".    Opening it automatically starts
up the MiniViewer with the document inside it.

Distributing the Common Ground MiniViewer
Although the Common Ground Maker and Viewer must be purchased, the Common 
Ground MiniViewer can be freely distributed to anyone for non-commercial use.    The 
Windows MiniViewer can be used only on Windows systems.    For Macintosh 
recipients, do not embed the MiniViewer.    They must use the Macintosh Viewer or 
MiniViewer.

There are two ways to distribute the MiniViewer:

1. Send the MiniViewer file (cgminivw.exe) to someone electronically, or copy it 
to a floppy disk and give it to the recipient.    OR,

2. Send a Common Ground file with the MiniViewer embedded within it.    You can 
embed the    MiniViewer in the document as part of the creation process.

For information on distributing the MiniViewer or complete Viewer for commercial 
purposes, contact No Hands Software.




